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WELCOME 
Congratulations on purchasing a Novatel Wireless V620 PC Card and Modem Manager.  Using our wireless PC Card with 
your laptop, you can connect to the Internet, corporate intranet, and your email while you're away from the office at high 
speed.  This manual will provide information needed to get started and effectively use your new PC Card and Modem 
Manager software.  

WIRELESS COMMUNICATIONS 
Important Notice 
Due to the transmission and reception properties of wireless communications, data can occasionally be lost or delayed.  
This can be due to the variation in radio signal strength that results from changes in the characteristics of the radio 
transmission path.  Although data loss is rare, the environment where you operate the modem may adversely affect 
communications. 
Variations in radio signal strength are referred to as fading.  Fading is caused by several different factors including signal 
reflection, the ionosphere, and interference from other radio channels.  
Novatel Wireless or its partners will not be held responsible for damages of any kind resulting from the delays or errors in 
data transmitted or received with the V620, or failure of the V620 to transmit or receive such data. 

SAFETY HAZARDS 
Do not operate the V620 in an environment that may be susceptible to radio interference resulting in danger specifically; 
 

 Areas where prohibited by the law 
 

o Follow any special rules and regulations and obey all signs and notices. Always turn off the host device 
and remove the modem from the card slot when instructed to do so, or when you suspect that it may 
cause interference or danger. 

 
 Where explosive atmospheres may be present 

 
o Do not operate your modem in any area where a potentially explosive atmosphere may exist. Sparks in 

such areas could cause an explosion or fire resulting in bodily injury or even death. Be aware and comply 
with all signs and instructions. 

 
o Users are advised not to operate the modem while at a refueling point or service station. Users are 

reminded to observe restrictions on the use of radio equipment in fuel depots (fuel storage and 
distribution areas), chemical plants or where blasting operations are in progress. 

 
o Areas with a potentially explosive atmosphere are often but not always clearly marked. Potential locations 

can include gas stations, below deck on boats, chemical transfer or storage facilities, vehicles using 
liquefied petroleum gas (such as propane or butane), areas where the air contains chemicals or particles, 
such as grain, dust or metal powders, and any other area where you would normally be advised to turn 
off your vehicle engine. 

 
 Near Medical and life support equipment 

 
o Do not operate your modem in any area where medical equipment, life support equipment, or near any 

equipment that may be susceptible to any form of radio interference. In such areas, the host 
communications device must be turned off. The modem may transmit signals that could interfere with 
this equipment. 

 
 On an aircraft, either on the ground or airborne 
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o In addition to FAA requirements, many airline regulations state that you must suspend wireless 

operations before boarding an airplane. Please ensure that the host device is turned off and your modem 
is removed from the card slot prior to boarding aircraft in order to comply with these regulations. The 
modem can transmit signals that could interfere with various onboard systems and controls. 

 
 While operating a vehicle 

 
o The driver or operator of any vehicle should not operate a wireless data device while in control of a 

vehicle. Doing so will detract from the driver or operator's control and operation of that vehicle. In some 
countries, operating such communications devices while in control of a vehicle is an offence. 

 

LIMITATION OF LIABILITY 
The information contained in this document is subject to change without notice and should not be construed as a 
commitment by Novatel Wireless Inc.  

COPYRIGHT 
©2004 Novatel Wireless, Inc. 
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1 GETTING STARTED 
In This Section 

 
 

• System Requirements 

• The V620 Package 

• The Novatel Wireless V620 PC Card 

• Care of Your V620 

• Getting Started 

 
This section will walk you through how to get started using your V620 PC Card. This includes software and driver 
installation, inserting the card so Microsoft Windows is able to detect and install the drivers for your V620 PC Card and 
setting up a data session to connect to the Internet. 
 

1.1 SYSTEM REQUIREMENTS 
 

 166 MHz or faster Pentium- compatible 

 Microsoft Windows 98 (Second Edition), Windows Millennium Edition (ME), Windows 2000 Professional, or 
Windows XP (Home, Professional, Media Center or Tablet PC Editions) 

 
 32 MB RAM  

 14 MB available hard drive space 

 CD-ROM drive 

 Type II, PC CARD slot ---  3.3V 

 

1.2 YOUR V620 PC CARD 
Your V620 PC Card fits into the PC card slot (Type II, 3.3V) of most Windows based laptop computers.  The V620 utilizes 
the Novatel Broadband Network to connect to the Internet transferring data at rates of 300-600 kbps, and bursts speeds 
of up to 2.4Mbps.  The Novatel V620 runs on Microsoft Windows 98, ME, 2000, and XP. The Modem Manager software 
will allow you to control and monitor your connection to the Novatel Broadband network.  It will also allow you to send 
and receive SMS (Short Messaging Service), get online help and has an address book. 
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Review the illustration below to familiarize yourself with the key components of the V620 PC Card. 
PC Card: this is the device when plugged into a Personal Computer provides wireless data solutions*   
Service/Data LED: visual indicator that shows you service and data modes 

  

External Antenna Jack: allows you to connect an optional external antenna to your PC card for improved performance. 
Computer Interface Connector:  connects to your Personal Computer via the computer PCMCIA slot 

 

1.3 CARE OF YOUR V620 
Novatel Wireless recommends the following handling guidelines:   
 

 Handle with care 

 Avoid storing your V620 PC Card in extreme temperatures 

 Store the card in a dry and clean environment 

 Avoid spilling any liquid or immersing the card in water 

 Do not place any labels on the Antenna as this may alter the sensitivity of the antenna 

 Do not place any labels on the card as this may interfere with the PC card slot when inserting 

 Do not force the V620 into the PC card slot 

 Do not apply force on the top or bottom of the V620 

When transporting your laptop, remove the V620 from the PC card slot 

 

1.4 THE V620 PACKAGE 
The V620 Package includes: 
 

 Novatel Wireless V620 PC Card 

 A CD which includes your Modem Manager software, User Manual, and Novatel Wireless’ Interactive User 

Guide 

 Quick Start Guide 

 

Computer Interface Connector
32 pin 

External antenna jack 

PC Card 
service/data LED 



 

GU-90023487 
Revision 4 
 
 

 

1.5 GETTING STARTED 
 
IMPORTANT:  DO NOT INSERT THE V620 INTO THE PC CARD SLOT UNTIL YOU HAVE INSTALLED THE MODEM MANAGER 
SOFTWARE (SEE SECTION 3 OF THIS MANUAL)  AND UNINSTALLED ANY PREVIOUSLY EXISTING BROADBAND PC CARD 
SOFTWARE FROM YOUR COMPUTER. 

2 MODEM MANAGER FROM NOVATEL WIRELESS: 
 
Welcome to the Novatel Wireless Modem Manager.  The Modem Manager provides a one-touch connection to the 
wireless Internet.  It has built-in support for WWAN and Wi-Fi devices to give you the flexibility you need while you are 
mobile to connect your laptop to the Internet wirelessly. 
 
 

2.1 SUPPORTED SERVICES 
Modem Manager supports the following services from Novatel Wireless: 
 
1. SM (14.4 kbps) - This requires a CDMA data capable phone and cable or PC Card. This allows connection directly to 
the Internet in less then 10 seconds. Then you can use your existing Internet browser or e-mail software. If you currently 
do not have e-mail software, you can sign up for web based e-mail at any of the popular portal sites, see section on Using 
E-mail with Mobile Office for additional information. This connection operates at 14.4 kbps. This is slower than a landline 
modem but works wirelessly and is billed the same as voice calls. 
2. Dial-Up-Data Service - This requires a CDMA data capable phone and cable or PC Card. This allows you to use 
your wireless device to dial into your corporate network, or other services you normally dial into, over a regular phone line. 
This connection operates at 14.4 kbps. This is slower than a landline modem but works wirelessly and is billed the same 
as voice calls. 
3.  - This requires a  capable wireless phone and cable or PC Card. This service works the same as the  service but 
typically at considerably faster data rates.  is capable of data speeds bursting up to 144 kbps, delivering average speeds 
of up to 40 to 60 kbps. This service requires subscription to a  plan. Additional information is available at 
www.Novatelwireless.com/b2c/mobileoptions//index.jsp. 
4.  - This requires a BrandbandAccess capable device and provides a wireless broadband connection to the Internet.  
 

 Note: You do not need a separate Internet service provider (ISP) to access the Internet when using , , or . 
 

3 INSTALLATION AND CONFIGURATION 
This section will guide you through the installation and setup process for the Modem Manager.  Before getting started, you 
should become familiar with the documentation that came with your mobile phone or PC Card. 
 
CDs 
1. If Modem Manager was obtained in a Mobile Office kit, install the USB drivers for your phone from Disc 1 before 
installing Modem Manager that is on Disk 2. 

2. If you purchased a PC Card, there is only one CD that contains Modem Manager and PC Card drivers.   
 
Getting Started 
Follow these steps to install Modem Manager: 
 
1. Turn on your computer and close all applications. 
2. Insert the CD-ROM into your CD drive. 
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3. If set up does not automatically start, click the Start button on the taskbar and choose Run. Type D:\Start (where D is 
the letter of your CD-ROM drive) and click OK. 
4. Follow the steps in the next section... 
 

Important: Modem Manager software must be installed before you insert the PC Card in to the computer for the 
first time.  Only after the software has been installed can Windows successfully install and configure the PC Card.  
 
 

3.1 THE MODEM MANAGER SETUP PROGRAM 
 
 Step 1  

Double-click the Modem Manager setup program.  You 
will be presented with a "Welcome" screen.  Click the 
Next button to continue with the installation process. 

 
 Step 2 

After the Welcome screen you will see the Modem 
Manager License Agreement.  In order to install and 
use this product you must agree with the terms of this 
agreement.  Select "I agree with this software license 
agreement", then click the Next button to continue.  If 
you do not agree with this agreement, click the Cancel 
button to exit. 

 
 Step 3 

You are now ready to select the location on your 
computer where the Modem Manager should be 
installed.  It is recommended that you do not modify 
the default destination folder.  Click the Next button to 
continue. 

 
 Step 4 

You are now ready to begin installing Modem Manager 
components onto your computer.  Click Next to 
continue. 

 
 Step 5 

During this step the components of the Modem 
Manager product are being installed onto your 
computer.  Installation will occur to the destination 
folder specified in Step 3 above. 

 
 Step 6 

Installation is now complete.  Click the Finish button to 
leave the Modem Manager setup program and begin 
using your new software 

 
The setup program will automatically create a Modem Manager shortcut on your desktop. 
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3.2 THE MODEM MANAGER SETUP WIZARD 
After you have successfully completed the installation process of Modem Manager, you are ready to start the Modem 
Manager program and begin your initial setup.  The steps in the Setup Wizard are critical to the proper operation of 
Modem Manager when using your WWAN or Wi-Fi device to connect to the Internet wirelessly. 
 
Step 1 
Click the Start button, select the Programs menu and choose the Modem Manager menu item to start the Modem 
Manager program. 
 
 Step 2 

On first-run of Modem Manager the Setup Wizard will 
automatically run.  You will be presented with a 
Welcome screen.   
 
If you have an Internet connection, it is recommend 
that you check to see if you are running the lastest 
version of Modem Manager.  Click the Check for 
Updates button to perform this check. 
 
Click Next to continue. 

 
 Step 3 

In this step of the Setup Wizard you must specify the 
type of wireless device that you intend to use with 
Modem Manager.  Select "Detect both Wi-Fi and 
WWAN", "Detect WWAN device only (1xEV-
DO/1xRTT/CDMA)".  For the purposes of this guide, 
"Detect both Wi-Fi and WWAN" will be used. Please 
note that your experience in Step 4 may be different if 
you use a different selection.  After making the 
appropriate selection, click Next to continue.  

 
 Step 4 

In this step Modem Manager will detect the Wi-Fi 
adapters on your computer.  If your computer has a 
built-in Wi-Fi adapter, you do not need to do anything 
and can proceed to the next step.  Otherwise, please 
insert your Wi-Fi PC Card now.  You will need the 
drivers for the card if not already installed on the 
computer.  Once complete, click Next to continue. 

 

  Note:  WWAN (Wireless Wide Area Network) denotes any 1xEVDO, 1xRTT such as ,  or .  
 
 Step 5 

The Modem Manager will now detect and setup your 
WWAN device. 

 
 Step 6 

In this step you need to select the type of connectivity 
you wish to use with your wireless device.  For the 
purposes of this guide, we will select "PC Card".  
Please note that this selection may not be appropriate 
for your type of wireless device.  Once you have 
selected your connectivity option, click Next to 
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continue. 
 
 Step 7 

In this step the Modem Manager will find your wireless 
device. 
 
If you selected USB and have not already installed the 
data cable drivers supplied with the cable, you must 
install them now.  To install the data cable drivers click 
the Cancel button below to exit the Setup Wizard and 
then refer to the documentation included with the 
cable.  Please plug the data cable into your wireless 
phone and then plug the cable into your computer.  If 
your wireless phone is not turned on, do so now. 

 
 For PCCard users, insert your PCCard now, and wait 

for Windows to detect and install drivers for the device. 
 
 Once your wireless phone is turned on and connected 

to your computer, click Next to continue.  At this point 
in the setup process Modem Manager will attempt to 
find your wireless device.  If a devione is found, you 
will see the following screen. 

 
Step 8 
The detection and configuration process for your wireless device is now complete.  In this step you can elect to run the 
Modem Manager automatically every time you start up your computer.  To do so, check the "Run Modem Manager at 
Startup" checkbox.  Click Finish when complete. 
 
After clicking the Finish button Modem Manager will launch the Venturi client install program.  Follow the on-screen 
instructions to install the Venturi client. 
 
Please familiarize yourself with the information in the "Using Modem Manager" and "Connecting to the Internet" sections 
of this guide.   
 
 

4 USING MODEM MANAGER 
Today's online world offers more services everyday and Novatel Wireless gives you the tools you need to take advantage 
of the best in connectivity solutions. With Modem Manager, enjoy the freedom and convenience of wireless Internet 
connectivity from your notebook computer! 
 
 

4.1 FEATURES 
WWAN (Wireless Wide Area Network, 1xEV-DO/1xRTT/CDMA) Specific Features: 
• Configures your PC to use your wireless phone and cable or wireless CDMA PC Card as a modem. 
• Creates a  (14.4 kbps) connection if supported by your device. 
• Creates a  connection if using a  capable wireless phone and cable or PC Card, which does not support . 
• Creates a  -  connection if using a  capable device. This connection will automatically fall back and attempt connecting 
via  if the  service is unavailable. 
• Test function for WWAN device.  
  
Wi-Fi Features 
• Configures Wi-Fi Adapter to work with Modem Manager. 
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• Displays Wi-Fi connections and signal strength when in a Wi-Fi coverage area.Supports connecting to Wi-Fi networks 
such as ones used at home or work. 
• Supports built-in Wi-Fi adapters or PC Cards. 
 

 A WWAN capable device is required to use the WWAN features. Individual WWAN features are also device 
dependent as described in the WWAN section above.  
 
Other Features: 
• Can also be used to launch all of your dial-up networking connections, if desired. 
• Can launch your browser, e-mail client, VPN or a program of your choice upon connection. 
• Logs connections used, duration and bytes sent and received. 
• See the section "Additional Features" for more information about the features of Modem Manager. 
• TXT messaging 
 
 

4.2 GETTING STARTED 
Double click on the Modem Manager icon on your desktop or click on the Windows Start menu and select Modem 
Manager from the list of Programs. 

 
About the Connect View 
The Modem Manager will open to the Connect view by default.   This view is where you manage your wireless 
connections.  The Connect view displays all currently available network connections.   
 
At a glance you can see the signal strength and battery level (if applicable) of your WWAN or Wi-Fi network.  Select 
"Refresh Networks" or "Refresh Signal Levels" from the "Options" menu to update the information in this panel.  Your 
current connection state and the elapsed time of the connection are displayed along the bottom of the status bar. 
 

 
 
If your expected connection does not appear or if you connected your wireless phone and cable, or inserted your wireless 
CDMA PC Card or Wi-Fi Card after starting Modem Manager, select "Refresh Networks" from the "Options" menu. This 
will cause Modem Manager to look for your wireless device(s) and verify network availability. If you have any Wi-Fi 
networks you manually added because they do not broadcast their ID, they will always be displayed, and you will have to 
refer to the signal strength displayed to know when you are in range. See the section "Wi-Fi Specific Settings" for 
additional details. 
 

 Note that with certain Wi-Fi adapters the signal strength for Wi-Fi networks is not accurate until you connect to the 
network.  
 
Note: The  (14.4 kbps) connection is only created when the WWAN option is selected during setup and if your wireless 
device supports it. The  connection is only created when the WWAN option is selected during setup and if you are using a  
capable device that does not support the Novatel Wireless  service. If you are using a  capable device a  -  connection will 
be created. This connection will use  if available and will automatically attempt a  connection when  is not available.  
 

 If you change phones or PC Cards, you will need to run the Setup Wizard again.  To do this make sure that your 
phone and cable are connected, then select "Run Wizard" from the "Options" menu.  
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4.3 CONNECTING  
Once your Wi-Fi or WWAN device is properly configured, connecting to the Internet is as simple as selecting the network 
connection type shown in the list and clicking the Connect button.  Note that the Connect button immediately above the 
list will change to "Connect WWAN" or "Connect Wi-Fi" as appropriate based on the current selection in the networks list. 
 
1. Click the "Connect WWAN" button when it becomes enabled.  
 
Once connected, the "Connect WWAN" button will change to "Disconnect".  Simply click this to end your current 
connection.  To connect to any other network shown, select it, and then select "Connect".  
 
The Status Bar 
Information regarding your current network connection can be seen in the status bar along the bottom of the Modem 
Manager interface.  For more information on this status bar, see the section "The Status Bar" in the "Additional Features" 
section.  
 
Note: If you are using a WWAN (1xEV-DO/1xRTT/CDMA) device that supports the Novatel Wireless Dial-Up-Data service 
and you made wireless copies of your dial-up accounts, they will also appear.  See the section "Creating Wireless Copies 
of your Dial-Up Connections".  Optionally you can have all dial-up connections appear in Modem Manager and use it to 
launch any dial-up networking connection.  See the section "Setting Your Preferences".  If you are in the presence of a 
private Wi-Fi network (such as one at work or at home) it will also appear if you selected the Wi-Fi option during setup. If 
the number of connections exceeds what can be displayed, a vertical scroll bar will appear to the right of the connections.  
Scroll down to see them all. 
 

  
Modem Manager will display status information at the bottom during the connection process as well as while connected.  
When not connected, the status text in the lower left corner will display "Not connected" for the currently selected network.  
The timer will display "00:00:00".  Once connected, the status text will display "Connected" and the elapsed timer will 
begin to run.  When a connection is active, its name will appear as bold text. 
 
The status is also reflected in the Task Tray icon. 

Connected 
Idle - Not Connected 
Connecting 
Disconnecting 
A window will also slide out of the tray showing when you connect and disconnect 
from networks. 

 
The pop up status can be turned off, if desired, by selecting "Options", "Preferences", "Options" tab, un-checking "Show 
popup status windows by tray". Right clicking on the tray icon provides various options and double clicking on it will 
always show the application. Placing your cursor on it will display the current connection status. 
 
Based on your preferences, your browser or e-mail or VPN program can be launched automatically, or you can launch 
whatever software you want to use. You can also determine if all connections show in the drop down list or only your 
wireless ones, see Setting Your Preferences. 
 
 
At any time during your connection you can check your current connection speed and throughput stats in the Statistics tab 
of the Session Information window.  To see this window, select "Statistics" from the "Options" menu. 
 
 
The Session Information window will also contain a My Computer tab and a Wi-Fi tab if applicable.  The My Computer tab 
contains detailed information about your computer.  This information is helpful when troubleshooting a problem. 
  
 
 



 

GU-90023487 
Revision 4 
 
 

 

4.4 USING DIAL UP CONNECTIONS 
This section is only applicable if you are using a WWAN Device that supports Dial-Up connections (a wireless 
phone and cable or a PC Card). 
 
You can make wireless copies of existing dial up accounts on your system.  This will wirelessly enable them and allow you 
to connect to them wirelessly. 
 
To launch the copy utility, select "Options", "Dial-up Accounts" then "Copy". 
 
Click on the connection or connections you want to copy and click on the "OK" button. 
  

 
 
The new connection will have a suffix of "(Wireless)" and will be set to use your wireless phone as the modem. If the utility 
is unable to automatically recognize your existing area code and number, the existing number will be displayed, and you 
will be prompted to enter the area code and number. The utility configures the new wireless connections to always dial 11 
digits, so that they will work locally and also in other digital data coverage areas. 
  
If it is determined that the connection might benefit by further optimization, an additional connection with a "(Wireless 
Optimized)" suffix, will also be created. This connection may connect faster. If you have trouble with the "(Wireless 
Optimized)" connection, you can delete it from your dial-up networking folder and use the "(Wireless)" connection. 
  
Note: Some applications, such as AOL and JUNO, have Dial-Up Networking connections that can't be used directly from 
Modem Manager or Dial-Up Networking. Copies of these connections will not work with your wireless phone, since the 
original connections do not work by themselves. In most cases the original connections or the software can be configured 
to use your wireless phone or CDMA PC Card as a modem. For the easiest way to configure AOL to work with your 
wireless phone, see the section on Configuring AOL. 
 
To delete connections: 
If you are using Windows 95, 98, or ME you can access Dial-Up Networking from Modem Manager by selecting "Options", 
"Dial-up Accounts", "Edit". To delete a connection, click on it to select it, and press the delete key. 
  
Windows 2000 and XP users can access Dial-Up Networking from Modem Manager by selecting "Options", "Control 
Panels", "Network and Dial-up Connections", right click on the desired connection and select "Delete". 
 
 

5 MODEM MANAGER PREFERENCES 
This section will cover the preferences that are common to both WWAN and Wi-Fi usage.  The next two sections will 
cover preferences unique to WWAN and Wi-Fi. 
 
 

5.1 GENERAL PREFERENCES 
This section will cover the preferences that are common to both WWAN and Wi-Fi. The next two sections will cover 
preferences unique to WWAN and Wi-Fi. 
 
Options Tab 
Click on "Tools", then "Preferences. . . ". 
 
  

 
  



 

GU-90023487 
Revision 4 
 
 

Only show preferred wireless networks at start up: This only applies to Wi-Fi networks. If checked, at startup, only 
networks in your Preferred list on the Wi-Fi tab are displayed (networks you have connected to in the past) otherwise, all 
detected networks are displayed. 
  

Display advanced Wi-Fi network information: This only applies to Wi-Fi networks. If checked, additional information will 
be displayed for Wi-Fi networks such as the channel, MAC address and type of security. 
  

Minimize Application into tray: With this option selected, when you minimize Modem Manager, instead of taking up 
space in your taskbar, it will just disappear. You can get it back by double clicking on the tray icon, alternatively you can 
right click in the icon and select "Show Application". You can minimize the main window of Modem Manager by selecting 
the minimize icon (  ) in the upper right corner of the main window. 
  

Show popup status windows by tray: Enables status notification in a pop up window above the task bar that displays 
for a few seconds whenever connection status changes. 
  

Run Modem Manager at Startup: Selecting this option adds Modem Manager to the Windows Startup group, unchecking 
it removes Modem Manager from the startup group. 
  

Automatically close conflicting applications: With this option selected, Modem Manager will automatically close any 
application it recognizes that is known to prevent it from working correctly. For example, it may close the client software 
that was supplied with your Wi-Fi card, if it's known to conflict with Modem Manager controlling your Wi-Fi card. 
 
For Wi-Fi, Passwords, and VPN options see section on Wi-Fi Specific Settings. 
 
For WWAN and Venturi options see section on WWAN Specific Settings. 
  

 
Updates Tab 
  

 
 
  

.  
  

You will be given the choice to download or cancel. If you select download, you will be presented with a display that 
shows the progress as the update is downloading with the option to cancel if desired. You do not need to download the 
updates wirelessly; you can use any connection to the Internet. Note: If you download the updates wirelessly, normal 
usage charges apply. 
  

You can allow the software to check automatically for updates, daily, weekly (default), or monthly. It only checks when the 
application is running and when it detects that you are connected and able to access to the Internet. If desired, you can 
select "Manually" and the software will only check for updates when you select "Update Now" (pictured above), or you 
when you select, from Modem Manager's main screen, "Help", "Check for Updates". 
 
 

5.2 WWAN SPECIFIC SETTINGS 
WWAN Preferences 
Click on "Tools", then "Preferences. . . ". 
 

WWAN Options 
  

 
   

Show wireless device battery instead of PC battery: If you only selected to detect and install Wi-Fi when installing 
Modem Manager, Modem Manager will display the PC's battery status in it's main window. If you are using a WWAN 
device and this option is selected, the battery level of your WWAN device will be displayed when your device is connected 
and detected by Modem Manager, as well as when you connect and disconnect using your WWAN device. Battery Status 
cannot be updated while you are connected. You can refresh the status when you are not connected, by selecting "Tools", 
"Refresh Signal Levels" from Modem Manager's main window. Some phones fail to accurately report their battery level to 
Modem Manager and some WWAN devices such as PC Cards do not use batteries, so you can use this option to display 
the PC's battery instead.   
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Set Options . . . : This is used to set various connect options.  See below. 
  

Show non-wireless accounts in list: If you select this option all of your dial up accounts will show up in Modem 
Manager's list of accounts, allowing you to use Modem Manager to launch them instead of Dial-Up Networking. With this 
option unchecked, the only connections that are displayed in Modem Manager's list of accounts, are the Novatel Wireless  
(14.4 kbps) connection, (depending on your wireless phone/device capabilities) and any Wireless connections you have 
created, manually or with the Copy Accounts Wizard. If Modem Manager is also configured for Wi-Fi, these connections 
will also be displayed when in coverage of the hot spot. 
  

Do not prompt for user name and password: If you are only using the Novatel Wireless (14.4 kbps) connection, this 
setting has no effect. If you created Wireless connections to dial into other networks or have existing connections you are 
going to launch using Modem Manager, checking this option will skip the screen that normally asks for your user name 
and password. For this to work you will have had to connect previously, successfully saving your user name and 
password. 
 
Connect Tab 
When you select the "Set Options" button from the screen above, the following options will appear ("Options", 
"Preferences", "WWAN tab", "Set Options. . . "): 
  

 
 

  
  

Do not open my browser: With this option selected, when you connect to a WWAN network, Modem Manager will not 
automatically launch your default web browser. 
  

Open my browser to my default home page: With this option selected, when you connect to a WWAN network ( - ,  or ), 
Modem Manager will automatically launch your default web browser and your  home page will load. 
  

Open my browser to this URL: With this option selected, when you connect to a WWAN network ( - ,  or ), Modem 
Manager will automatically launch your default web browser but do it in such a way that the URL you specify will load 
instead of your home page. 
  

Turn off graphics: If you select this it will turn of graphics in Internet Explorer. 
  

Turn off audio: If you select this it will turn off audio in Internet Explorer.  
  

With these options off, web pages will load faster but you will have to right click and select "show picture" for any pictures 
you want to see. With the added performance of the Venturi compression software when using the Novatel Wireless  - ,  
or  (14.4 kbps) connection, most users prefer to see graphics and have audio support, so the default setting for both 
options is unchecked. 
  

Run program on connection:  This allows automatically running a program when you use Modem Manager to connect 

to a WWAN network. Select  the browse button, , to browse to the desired application you want to run when you 
connect to a WWAN network using Modem Manager. The application will run for all WWAN connections made from 
Modem Manager.  
 
VPN Tab 
The following options exist on the VPN tab ("Options", "Preferences", "WWAN" tab, "Set Options. . . ", "VPN" tab): 
  

 
  

Disable: When you connect to a WWAN network, Modem Manager will not automatically launch your VPN client. 
  

Microsoft VPN: If the network you are connecting to supports using Microsoft's VPN, you can select this option and 
select the VPN connection you normally use from the drop down list. You can also use the "Add VPN" to create a 
Microsoft VPN connection. When you use Modem Manager to connect to a WWAN network, it will automatically launch 
your VPN connection. 
  

Cisco VPN: If Cisco VPN software is installed, you can select this option to cause Modem Manager to automatically 
launch your Cisco VPN software when you connect to a WWAN network using Modem Manager. 
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Other VPN Application: This allows automatically running any VPN program when you use Modem Manager to connect 

to a WWAN network. Select  the browse button, , to browse to the desired VPN application you want to run when you 
connect to a WWAN network using Modem Manager. The VPN application will run for all WWAN connections made from 
Modem Manager. If you have a shortcut you normally use to launch your VPN application you may want to right click on it 
and select properties to see where the program is located and how it's named. 
 

6 ADDITIONAL FEATURES 
In addition to the basic features mentioned in previous sections, Modem Manager has the additional features listed below. 
 
 

6.1 THE STATUS BAR 
The details of your current connection can be seen in the status bar at the bottom of the Modem Manager interface.  This 
status bar is always visible when the interface is fully expanded.  For information on minimizing the Modem Manager 
interface, see the section "Minimizing the Interface". 
 

 
Connection Status 
The text on the top left portion of the status bar above the "Novatel Wireless" text reflects your current state.  During an 
active connection, this text will change to "Connected".  If you are not connected, it will display "Not Connected". 
 
WWAN PCCard Status Area 
The text that reads "Novatel Wireless" can change to the following: 
• Device not inserted - Your WWAN PC Card is removed from the laptop. 
• Device not activated - Your PC Card needs to be activated.  Select Activate from the Options menu. 
 
Coverage 
For PC Cards, an icon will display if you are in  or  coverage.  Hover the mouse to see the tool tip showing the name of 
the current network. 
 
New TXT 
If your device supports TXT messaging, an icon appears on the status bar to show that you have a new TXT message 
waiting.  Double click on the icon to jump to the TXT view to see the message. 
 
Throughput 
The amount of data that you have sent and received since the current network connection was initiated can be seen by 
holding the mouse over the green up and down arrows on the right side of the status bar. 
 
Battery Level 
The current battery level of your mobile phone can be seen on the right side of the status bar.   
 
Elapsed Time 
The amount of time that has elapsed since the current network connection was initiated is tracked on the lower right side 
of the status bar. 
 
 

6.2 THE TOOLBAR BUTTONS 
 

 
 
The "Connect" button 
Displays all of your available wireless connections and networks.  Please refer to the Connecting section earlier. 
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The "Usage" button 
Provides a concise session log of your network activity.  Click on a column heading to sort the log.  This window also 
displays the total number of sessions as well as the total time connected.   
 
The information displayed in the Usage log can be customized using the controls that appear just below the list. 
 
To view only the connection history of a specific network type, check the "Selected connection" checkbox and select the 
desired type from the drop-down list.  To view only the connections made during a specific interval, check the "Date 
range" checkbox and specify the date in the "From:" and "To:" fields. 
 
To export this log as a CSV file, click the Export button that is immediately above the log.  To clear the log, press the 
Clear button.  Note that clearing the log cannot be undone. 
 
The "Apps" button 
Add applications here that you want easy access to while connected to the wireless Internet.  Modem Manager will pre-
load into this view links to Novatel Wireless web sites, and any Microsoft Office applications you have loaded on your 
computer. 
 
The "TXT" button 
The TXT button allows you to send short text messages to any other wireless device that supports SMS.   Note that this 
button is only available when using a wireless device that supports SMS. 
 
The "Web" button 
Launches the default web browser on your computer. 
 
The "Email" button 
Launches the your default email application on your computer. 
 
The "Support" button 
Displays a variety of help options available to you.  Click this button to find assistance with a problem, to explore the full 
range of  products and services, or to contact Novatel Wireless. 
 
 
 

6.3 MINIMIZING THE INTERFACE 
The Modem Manager interface can be minimized to take up as little screen real estate as possible.  To minimize the 
interface, select "Minimum" from the "View" menu. 
To return the Modem Manager interface to the normal size, select "Minimum" from the "View" menu again. 
 
 

6.4 THE TOOLS MENU 
Control Panels:  From this menu you have access to your systems "Modem", "Network and Dial-Up Connections", and 
"Internet" control panels.  You can also see all control panels by selecting "All". 
 
Dial-Up Accounts:  Add, edit, or copy wireless dial-up accounts. 
 
• Add Wireless: This is used to create a wireless dial-up connection from scratch. 
• Add Other: This is used to create a regular dial-up connection from scratch. 
• Edit: This is used to edit properties of any dial-up connection. 
• Copy: See section on Using Dial-Up Connections. 
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7  PRODUCT SPECIFICATION 
In This Section 

 
 

• Technical and Environmental Specifications  
 

 
 

7.1 TECHNICAL SPECIFICATION 
This section outlines the technical and environmental specifications of your V620 
 

Name: V620 
Model Number: V620 
Approvals: FCC  
Dimensions: 122 x 54 x 5 mm 
Wireless Network Novatel Broadband 
PC Card Standard: Type II PC Card 

3.3V 
TABLE 1 

 
 

Technology: 1xEV-DO 
Band Designation: 1xEV-DO 1900Mhz 
Cellular Band: CDMA 800Mhz 
PCS Band: CDMA 1900Mhz 
Power Output/Transmit 
Power 

Class 4  (+21dBm) 

TABLE 2 
 

7.2 ENVIRONMENTAL SPECIFICATION 
 

Operating Temperature -20° Celsius to+70° Celsius 
Storage Temperature -40° Celsius to +85° Celsius 
Relative Humidity 95% maximum – Non Condensing 
Vibration 147 m/s2 (15Gpeak) 10hz-2000hz 

TABLE 3 
 

8  SAFETY REGULATIONS 
In This Section 

 
 

• Wireless Communication 

• Safety and Hazards 

• Regulatory Information 
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This section will inform you of the important safety measures you should be aware, including the standards that the 
modem complies to. 
 

8.1 WIRELESS COMMUNICATIONS 
Important Notice 
Due to the transmission and reception properties of wireless communications, data can occasionally be lost or delayed.  
This can be due to the variation in radio signal strength that results from changes in the characteristics of the radio 
transmission path.  Although data loss is rare, the environment where you operate the modem may adversely affect 
communications. Variations in radio signal strength are referred to as fading.  Fading is caused by several different factors 
including signal reflection, the ionosphere, and interference from other radio channels.  Novatel Wireless or its partners 
will not be held responsible for damages of any kind resulting from the delays or errors in data transmitted or received 
with the V620 PC Card, or failure of the V620 PC Card to transmit or receive such data. 

8.2 SAFETY HAZARDS 
Do not operate the V620 in an environment that may be susceptible to radio interference resulting in danger specifically; 
 

 Areas where prohibited by the law 
 

o Follow any special rules and regulations and obey all signs and notices. Always turn off the host device 
and remove the modem from the card slot when instructed to do so, or when you suspect that it may 
cause interference or danger. 

 
 Where explosive atmospheres may be present 

 
o Do not operate your modem in any area where a potentially explosive atmosphere may exist. Sparks in 

such areas could cause an explosion or fire resulting in bodily injury or even death. Be aware and comply 
with all signs and instructions. 

 
o Users are advised not to operate the modem while at a refueling point or service station. Users are 

reminded to observe restrictions on the use of radio equipment in fuel depots (fuel storage and 
distribution areas), chemical plants or where blasting operations are in progress. 

 
o Areas with a potentially explosive atmosphere are often but not always clearly marked. Potential locations 

can include gas stations, below deck on boats, chemical transfer or storage facilities, vehicles using 
liquefied petroleum gas (such as propane or butane), areas where the air contains chemicals or particles, 
such as grain, dust or metal powders, and any other area where you would normally be advised to turn 
off your vehicle engine. 

 
 Near Medical and life support equipment 

 
o Do not operate your modem in any area where medical equipment, life support equipment, or near any 

equipment that may be susceptible to any form of radio interference. In such areas, the host 
communications device must be turned off. The modem may transmit signals that could interfere with 
this equipment. 

 
 On an aircraft, either on the ground or airborne 

 
o In addition to FAA requirements, many airline regulations state that you must suspend wireless 

operations before boarding an airplane. Please ensure that the host device is turned off and your modem 
is removed from the card slot prior to boarding aircraft in order to comply with these regulations. The 
modem can transmit signals that could interfere with various onboard systems and controls. 



 

GU-90023487 
Revision 4 
 
 

 
 While operating a vehicle 

 
o The driver or operator of any vehicle should not operate a wireless data device while in control of a 

vehicle. Doing so will detract from the driver or operator's control and operation of that vehicle. In some 
countries, operating such communications devices while in control of a vehicle is an offence. 

 

8.3 REGULATORY NOTICES 
 
Federal Communications Commission Notice (FCC -- United States) 
 

 
Electronic devices, including computers and wireless modems, generate RF energy incidental to their 
intended function and are therefore subject to FCC rules and regulations.  
This equipment has been tested to, and found to be within the acceptable limits for a Class B digital 
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a residential environment. 

This equipment generates radio frequency energy and is designed for use in accordance with the manufacturer’s user 
manual. However, there is no guarantee that interference will not occur in any particular installation. If this equipment 
causes harmful interference to radio or television reception, which can be determined by turning the equipment off and 
on, you are encouraged to try to correct the interference by one or more of the following measures:  
 

• Reorient or relocate the receiving antenna  
• Increase the separation between the equipment and the receiver  
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected 
• Consult the dealer or an experienced radio/television technician for help 

 
This device complies with Part 15 of the Federal Communications Commission (FCC) Rules. Operation is subject to the 
following two conditions: 
 

1. This device may not cause harmful interference.  
2. This device must accept any interference received, including interference that may cause undesired operation.  

 
 
WARNING: DO NOT ATTEMPT TO SERVICE THE WIRELESS COMMUNICATION DEVICE YOURSELF. SUCH 
ACTION MAY VOID THE WARRANTY. THE V620 PC CARD MODEM OEM IS FACTORY TUNED. NO CUSTOMER 
CALIBRATION OR TUNING IS REQUIRED. CONTACT NOVATEL WIRELESS TECHNICAL SUPPORT FOR 
INFORMATION ABOUT SERVICING YOUR WIRELESS COMMUNICATION DEVICE. 
 
FCC CAUTION: Any changes or modification not expressly approved by the party responsible for compliance could void 
the user’s authority to operate this equipment. 
  
NOTE: The Radio Frequency (RF) emitter installed in your modem must not be located or operated in conjunction with 
any other antenna or transmitter. 
  
MODIFICATIONS: The FCC requires that you be notified that any changes or modifications made to this device that are 
not expressly approved by Novatel Wireless, Inc. may void your authority to operate the equipment. 
 

8.4 RF EXPOSURE/SPECIFIC ABSORPTION RATE (SAR) INFORMATION 
 
This product has been evaluated for SAR and meets the FCC Guidelines for exposure to radio waves. 
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FCC Equipment Authorization ID: PKRNVWV620 
 
Your wireless modem is a radio transmitter and receiver. It is designed and manufactured not to exceed the exposure 
limits for radio frequency (RF) energy set by the Federal Communications Commission (FCC) of the U.S. Government. 
These limits are part of comprehensive guidelines and establish permitted levels of RF energy for the general population. 
The guidelines are based on standards that were developed by independent scientific organizations through periodic and 
thorough evaluation of scientific studies. The standards include a substantial safety margin designed to assure the safety 
of all persons, regardless of age and health. 
 
The exposure standard for wireless devices including mobile phones and wireless modems uses a unit of measurement 
known as the Specific Absorption Rate, or SAR. Tests for SAR are conducted using standard operating positions reviewed 
by the FCC with the device under test transmitting at its highest certified power level in all frequency bands. Although the 
SAR is determined at the highest certified power level, the actual SAR level of the phone or modem while operating can 
be well below the maximum value. This is because the phone or modem is designed to operate at multiple power levels 
so as to use only the power required to reach the network. In general, the closer you are to a wireless base station 
antenna, the lower the power output. 
 
Before this device is made available for sale to the public, it must be tested and certified to the FCC that it does not 
exceed the limit established by the government-adopted requirement for safe exposure. The tests are performed in 
positions and locations (for example, at the ear or worn on the body) as required by the FCC for each model.  
THE FCC HAS GRANTED AN EQUIPMENT AUTHORIZATION FOR THIS WIRELESS MODEM WITH ALL REPORTED SAR 
LEVELS EVALUATED AS IN COMPLIANCE WITH THE FCC RF EXPOSURE GUIDELINES.  THE HIGHEST SAR VALUE FOR 
THIS MODEM WHEN TESTED FOR COMPLIANCE AGAINST FCC STANDARDS WAS 1.33W/kG. 
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